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Safety precautions 

⚫ Be sure to thoroughly read the instruction manual before using the products. 
⚫ Keep the instruction manual in a safe, convenient location for future reference. 
⚫ All or part of the contents described in this manual may be changed without any notice. 
⚫ Due to our constant striving for further improvement of products, parts or products that differ from those 

described in this manual may be substituted. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

WARNING (Failure to observe this WARNING may cause a fatal or serious injury.) 

・Be sure to confirm that any peripheral equipment does not move before installation work. 
In addition, observe safety requirements for installation work where high-place work is expected. 

・Be sure to turn off the power source before wiring, mounting and transportation work. 
  (Failure to observe this WARNING may result in an electric shock/ injury or equipment damage due to 

 short-circuit.) 
・Carry out wiring work correctly with reference to a proper drawing. 
・Never disassemble the equipment. 

(Failure to observe this WARNING may result in an electric shock.) 
・Do not open the cover under an explosive environmental condition when power is entered. 
  (Failure to observe this WARNING may result in an injury or equipment damage.) 
・Do not place or store the equipment in any hostile environmental place where it will be subjected to 

direct sunlight, rain, water droplet, hazardous gas / water, etc.. 

！ 

   CAUTION (Failure to observe this CAUTION may cause a moderate injury or equipment damage.) 

・Do not use the equipment for any purpose other than the original purpose of use. 
・Be sure to confirm the specification of equipment and use the equipment within the range of specification. 

(Mounting conditions such as temperature, power source, frequency, etc.) 
・Make sure a correct wiring before applying power source. 
・Do not have a shock or strong impact to the equipment. 

(Failure to observe this CAUTION may result in equipment damage.) 
・Be sure to connect necessary terminals (grounding, etc.). 
・Remove all wiring to the equipment before doing electrical welding work near the equipment. 
・Do not forcedly bend or pull the lead wire also do not use unnecessarily long wire. 
・Tighten the cover, lead outlet, etc. properly so that dust, rainwater, etc. do not enter inside the equipment. 
・Do not use the equipment under a corrosive condition (NH3, SO2, CI2, etc.). 
・Be sure to tighten the cable grand so that outer air does not enter inside the equipment. 
・When applying piping connection such as conduit, etc. instead of cable gland, apply putty or equivalents 

On the cable entry so that outer air does not enter inside the equipment. 

     IMPORTANT (indicates notes or information to help customers.) 

Limitations of Warranty: 
・Warranty period shall be one year from the date of delivery (ex-factory).  
・Any damage of any other products that have occurred for use of the equipment is not covered by  

this warranty.  Also any loss induced by failure or malfunction of the equipment is not covered by  
this warranty. 

・Failure or malfunction caused by following are not covered by this warranty: 
a. Modification or repair by a party other than MATSUSHIMA’s authorized personnel, or replacement of 

    parts not recommended by MATSUSHIMA. 
b. Inadequate storage, installation, use, inspection or maintenance that does not comply with specifications. 
c. Cause for any peripheral equipment or device. 
d. Accident beyond control and force majeure (fire, earthquake, flood, riots, etc.). 

 
Lack of instructions to MATSUSHIMA for information or safety requirements that can be predicted only by 
customers’ side. 
 
This warranty conditions do not limit customers’ legal right. 
 
Price for the equipment does not include any charge for services such as commissioning, supervising, etc.. 

！ 

！ 
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1. Software use conditions 

Software: 

*PACTware software (Copyright: PACTware Consortium e.V.) 

*Matsushima DTM software (Copyright: Matsushima Measure Tech Co., Ltd.) 

 

The PACTware software, Matsushima DTM software and related documentations, whether on disk, on 

compact disc, in read only memory, online, or any other media, are collectively referred to as the "Software". 

 

1.1 Agreement 

Matsushima Measure Tech Co., Ltd grants to User (either as an individual or legal entity) non-exclusive, 

non-transferable, license to use the Software and documentation solely for User's own internal personal or 

business purposes. 

The PACTware software and related documentations are license granted by PACTware Consortium e.V to 

Matsushima Measure Tech Co., Ltd. 

 

The Software must be installed and used only on one PC. 

You may not duplicate, sell or transfer the Software to any third party and may not run the Software from 

one computer to other computer through network. 

User may not modify, translate, rent, lease or create derivative works based upon the Software or any part 

thereof. 

Matsushima Measure Tech disclaims any warranty for the Software. The Software is provided "as is" without 

any warranty of any kind, especially the running of the Software or the use for a special purpose. 

 

1.2 Data protection 

PACTware software, related documents and its technical parts, algorithm, process know how is protected 

by copyright and international copyright contracts as well as by further laws and contracts of intellectual 

property. 

Matsushima DTM software, related documents is protected by copyright intellectual property of 

Matsushima Measure Tech Co., Ltd. 

User shall not disclose or leak, to any third party other than essential employees of User that have a need 

to know, confidential information or other data related to the Software and documents provided by 

MATSUSHIMA MEASURE TECH Co., Ltd. User shall use same degree of care to protect the confidential 

Information as User uses to protect and store its own confidential information. 

 

1.3 Restrictions on reverse engineering and others 

You may not reverse engineer (attempts to extract technical information from the Software and related 

documents including investigation, analysis and examination) decompile, disassemble, or otherwise 

reduce the Software to human-perceivable form. 
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2. Overview 

This product "MWTM-PR26 HART DTM" (hereinafter abbreviated as “Matsushima DTM”) is software with a 

dedicated maintenance function for the 26 GHz band microwave level meter, and performs parameter setting 

and waveform adjustment of the level meter. 

Matsushima DTM" is used as the device DTM and operates on the frame application "PACTware" together 

with the communication DTM. 

・DTM (Device Type Manager)： 

DTMs are adjustment software module for field devices, which operate on the frame application. 

・PACT ware (Process Automation Configuration Tool)： 

PACT ware is a tool for adjusting field devices and is frame application software which is not dependent 

on the device manufacturer. 

The communication with field devices is established using HART protocol via Communication DTM. 

 

● System requirements 

Table 1. Operating Environment 

 

※1）Windows 95, 98, ME, NT 4.0 and Windows 2000, XP are not supported by PACTware 5.0. 

※2）Windows 11 is not supported by PACTware 5.0. 

Matsushima DTM set in only English is confirmed to work for PCTware5.0.  

※3）Matsushima DTM has ability to record echo waveform data. If waveform data will be recorded 

for duration of three or more days 2GB or more RAM is required. 

※4）When Windows update (program update) is executed, the Windows registry may be cleared and 

 it may cause an error for DTM of the HART communication. 

※5）When using a PC on which the DTM software for another brand is installed, if the COM port 

 conflicts between the other company’s communication DTM and the HART communication DTM, 

 the Windows registry may be cleared and it may cause an error for DTM of the HART 

 communication. 

 

Software Supported 

 OS      （※1） Windows Vista and Windows 7,8,10 （※2）11 ① 

Frame Application PACTware 5.0 ② 

Execution environment  Microsoft.NET Framework 3.5 and 4.0 or higher ③ 

Device DTM Matsushima DTM (MWLM-PR26 HART DTM V.2.0.00 or higher) ④ 

Generic HART DTM (V.4.0.3 or higher) ⑤ 

Communication DTM HART Communication FDT1.2 DTM (V.1.0.52 or higher) ⑥ 

HART Modem Driver MHM-01:USB Virtual Serial Port Driver (HM-USB-ISO) ⑦ 

MHM-02:COP-HU Driver ⑧ 

Hardware Supported 

 Processor CPU 1GHz or higher 

RAM  （※2） 512MB or higher 

Hard disk 1GB free disk space 

Graphic resolution 1024 x 768 resolution or higher 

Interface USB 1 port or higher 

CD-ROM Driver For software installation 

Mouse and positioning 
Device 

Microsoft compatible or an equivalent pointing device 

HART Modem MHM-01, MHM-02（Recommended） 

Other 

 Matsushima DTM has the function to convert the parameters into a CSV file. 

Installation of “Microsoft Excel” is recommended when referencing CSV file parameters. ⑨ 

Adobe Acrobat Reader (Recommended) ⑩ is used when referencing pdf files. 
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①③⑨ ：are trademarks of Microsoft Corporation 

     ②    ：is trademark of PACTware Consortium e.V 

     ③     ：Microsoft.NET Framework 3.5 and 4.0 or higher is prerequisite for PACTware 5.0. 

     ④   ：is trademark of Matsushima Measure Tech Co., Ltd 

     ⑤   ：is a registered product of ICS GmbH 

     ⑥   ：is a registered product of CodeWrights GmbH 

     ⑦ ：are a registered product of ProComSol Ltd 

  ⑧ ：is a registered product of MG CO., LTD 

     ⑩   ：is a registered product of Adobe Systems Incorporated 
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3. Connection configuration 

The level meter can be connected to the personal computer via HART modem. There are following two connection 

methods: 

  a. Direct connection across the level meter check terminals 

  b. Connection across load resistor on the signal line 

If you are normally monitoring the measured waveform, etc. then connect it to the signal line. 

 

  Important：  

・The interface connection to the HART network is polarity insensitive. 

・Load resistor of 250Ω is required to allow communication with level meter. 

Load resistance (total of load resistor 250 Ohm plus cable resistance) must be less than 

650 Ohm at 24V. For other configurations, please refer to graph shown in Fig. 2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.1. Example connection between the level meter and the computer 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.2. Loop voltage versus loop resistance 

 

HART modem 

 

DC24V 

Loop Power Supply 

AC 

Power 

Source 

a．When connecting directly to the level meter 

Interface： Check terminal USB port 

Level meter 

! 

＋ 

－ 

※Load resistor of 250Ω is 

required. Field 

b．When connecting to the signal line 

Interface: Either side of the load resistor 

ＰＣ 
PACTware / 

Matsushima DTM 
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4. Starting the program 

After installing the adjustment software, double-click the ｢MatsushimaDTM.PW5｣ icon on the desktop. 

Login dialog with password entry is displayed. 

Do not input anything in the password entry just click OK . The root view initial screen will be displayed. 

 

 

 

 

 

 

 
 

 

 

 

 

Fig.3. Procedure of starting the Matsushima DTM  

 

After the initial screen is displayed, click "Device" → "Connect" on the tool bar. 

 

 

 

 

 

 

Fig.4. Device menu Connect 

 

Once you click ｢Connect｣, the level meter and the PC will be connected. (Offline → Online) 

Upload confirmation dialog will be displayed, click OK   . 

 

 

 

 

 

 

 

 

 

     Fig.5. Upload confirmation dialog 

  

After you confirm with OK button all sensor parameters will be uploaded to the DTM. 

 

 
 
 

※Click the  OK  button to upload 

parameters from the sensor. 

Do not enter any [Password] 

click「OK」. 

Double-click on the 

desktop icon 

 

Initial screen 
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  ※ If connect request failed by clicking『Device』→ ｢Connect｣, then dialog shown below will be 

displayed. 

 

 

 

 

 

 

 

Fig.6. Device scan dialog 

 

   ※Please verify following, if connection failed and above dialog displayed. 

・HART polling address is correct against level meter address. 

・Loop wiring correct. 

・Loop resistance within specified limit. 

・HART modem connected across loop resistor or across level meter terminals. 

・COM port setting number is the HART modem COM port number 

・HART modem driver installed completely. 

・Level meter powered on and there is loop current. 

 

   If the HART polling address is different than the level meter address, click the Yes(Y) button. 

   Search will start from address 0 until find matching level meter. Polling address range is 0 to 63. 

   Please be patient because it may take a few minutes. 

 

   If you can not find problem then click the No (N) button, and return to initial screen. 

 

  ※If the login dialog with password entry is not displayed 

   (Reasons why the login dialog may not be displayed) 

・Software might not installed correctly according to installation procedure 

・There is the possibility that the ｢PACTware｣ auto start settings are incorrect. 

Perform the following setup. (See page 38 for more details) 

 

 1）Auto start settings 

Adjust PACTware optional settings so that the Matsushima DTM starts by desktop shortcut icon. 

 

2）Change the language settings 

Change to the following languages because the default language for the DTM is English. 

English, Japanese, Korean, Chinese. 

※For Windows 11, only English setting is available. 

 

3）Change the startup file name (MatsushimaDTM.PW5) 

Perform this setup if you are changing the desktop icon name from 『MatsushimaDTM.PW5』 to a 

different name. 

  ※The file extension .PW5 must not be changed. 
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5. Initial screen and setting items 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.7. Initial screen 

 

a：Identification area 

This area contains information about the device: device type, serial number and company logo. 

b：Application area. The content of this area depends on the selected application. This example displays 

root view, which contains measured values in progress bar. 

       Distance →Distance from the level meter (m) 

       Level distance →Distance from the 0% level set (m) 

       Level percent →Measured percentage from the 0% level set (%) 

       Current value →The measured current value for the measurement span (mA) 

c：Action area 

『OK』button ・・・All parameter values will be transmitted to the level meter and closes  

Matsushima DTM. 

      『Cancel』button ・・Closes Matsushima DTM. 

      『Accept』button ・・All parameter values will be transmitted to the level meter. 

d：Measured value area. Selects the display value from 『Distance』、『Level distance』and『Level 

percent』. 

      ※The Current value is always displayed. 

e：DTM menu bar and navigation tree 

Selection of a menu item opens the related screens. 

The navigation tree provides an overview of the whole parameter set. Within the tree the 

parameter sets are grouped to appropriate parameter groups. When selecting a navigation tree 

entry the corresponding parameter group displayed in the application area. 

        (See the next page for the different settings.) 

f：Tool bar 

        The tool bar contains menu entries which are directly related to the application area.  

g：Status bar 

The Status Bar contains global status information about the DTM and level meter. 

e：Navigation tree 

    The navigation tree is used for selecting different applications. Detailed structure of navigation tree is 

shown below in Fig. 8. 

ｅ 

ａ 

ｃ 

ｄ 

ｂ 

g 

f 
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Fig.8. Extended view of navigation tree 

 

 

DTM menu bar 

 

Navigation tree (User setting) 

 

  

File 

Performs 『Parameter upload (Sensor → PC)』,  

『Parameter download、(PC → Sensor)』,『CSV Conversion』and 

『File header edit』 

Language 
Selects display language from 『English』,『日本語』(Japanese), 『한국어』

(Korean) or『中文』(Chinese) 

Help Displays『User’s Manual』, 『Software version』and 『Contact Info』. 

Sensor identification Changes parameters『Tag』,『Descriptor』,『Message』and『Date』. 

Basic Setting Sets the『Application』,『Measurement range span』and『Damping』. 

Sensor adjustment 
Sets the『Current output setting』,『Echo learning』and『Time window 

adjustment』. 

Graph display Displays the『Trend curve』or『Sensor trend』. 

Self test Executes a『Self test』. 

Reset Performs either of『Measurement data reset』and『Parameter reset』. 

Current output test Do simulation『Current output test』. 

HART Communication setting 
Changes parameters『Polling address』and『Preamble number』and 

『Multi-drop mode』and 『Dynamic variable(PV,SV,TV)』. 

Information Displays the『Sensor information』and『HART information』. 

LCD display setting 
Changes display parameters of LCD display unit  

『GRAPHIC COM : GC』. 

Detailed 
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DTM Menu bar 【Detailed explanation of each item】 

・File menu 

   “File” menu entries are shown below. 

 

 

 

 

 

Fig.9. File menu entries 

 

   『Parameter upload (Sensor → PC) 』： 

Upload parameters from the level meter and save parameter set values as a file. 

This function is useful when you would like to backup the parameter set values in a file. 

However, be aware that echo learning data will not be saved. 

 

   『Parameter download (PC → Sensor) 』： 

Open previously saved file in the PC which contains parameters set value and transfer parameters to 

the level meter. 

This function is useful when you would like to transfer same parameter set to another level meter. 

    However, be aware that echo learning data will not be transferred. 

 

『CSV Conversion』： 

There are two types of CSV (comma separated value) conversions. 

・Parameter file ：Convert the level meter parameter set file to CSV format. 

               (All parameters except echo learning data will be converted.) 

・Echo trend      ：Extract level meter parameter set from the echo trend data file and export to CSV 

format file. 

(All parameters except echo learning data will be converted.) 

Important：Before opening CSV file in MS Excel, please open the CSV file once in text 

editor like Notepad and then do “Save” overwrite. 

 There is possibility that multi-byte characters (like Japanese, Korean or 

Chinese etc.) appear not correctly. 

 

『File header edit』： 

You can assign fixed prefix in the name of files like parameter file, CSV file and echo trend file. 

If you do not edit the file header the name of the file will be constructed automatically from current date 

and time. 

※It is also possible to input custom name in the file name entry of file save dialog. 

If the header has been edited the name of the saved file will be the entered prefix + date and time. 

    ※It is also possible to edit file name in the file save dialog. 

 

・Language menu 

   “Language” menu entries are shown below. 

 

The selected language will be effective after restarting Matsushima DTM. 

Default language = English 

*For Windows 11, only English is supported.  
(If set to other language, it may be displayed incorrectly.)  

 

 

 

Fig.10. Language menu 

 

! 
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・Help menu 

   “Help” menu entries are shown below. 

 

 

 

 

 

 

 Fig.11. Help menu 

『User’s manual』  ：Displays the Operating manual in a PDF format. 

『Software version』  ：Displays the DTM software version and the copyright information. 

『Contact info』     ：Displays the contact information. 

Navigation tree 【Detailed explanation of each item】  

・Sensor identification 

『Tag』  ：Changes tag name for the level meter. 

Input characters: Capital letter alphanumeric characters only, less than 16 

characters.  Default: SENSOR 

『Descriptor』 ：Changes descriptor for the level meter. 

Input characters: Capital letter alphanumeric characters only, less than 16 

characters.   Default: PULSE-RADAR 

『Message』       ：Changes message for the level meter. 

Input characters: Capital letter alphanumeric characters only, less than 32 

characters.  Default: LEVEL METER 

『Date』  ：Sets the date when the tag or message was changed. Default: 2018/01/01 

・Basic setting 

『Application』      ：Changes measurement application setting. 

・Measurement unit  →［m］/［ft］ 

・Measuring object  →［Liquid］/［Solid］ 

・Level change rate  →［Normal(<=1m/min)］/［Fast(>1m/min)］ 

Default values: Measurement unit = [m], Measuring object= [Liquid],  

Level change rate = [Normal (<1m/min)] 

『Measurement range span』：Sets full/empty distance and related percentage. 

Default values: full - 0m - 100%, empty - 70m - 0%  

『Damping』：Sets amount of damping in number of seconds to respond fast step inputs. Default: 0s 

・Sensor adjustment 

『Current output setting』：Sets 0 to 100% current output setting and device failure current output 

setting. Details are as following. 

・0 to 100％ Current output selection →［4 to 20mA］/［20 to 4mA］ 

・Alarm current selection →［Hold］/［Max］/［Min］/［Selected value］ 

Default values: 0 to 100% Current output selection = 4 to 20mA 

Alarm current selection = Hold. 

『Echo Learning』：Sets mask to unwanted reflections (false echoes or noise echoes) reflected from 

obstructions in the tank. Default: No echo learning data 

 

Important：Echo learning setting input the masking distance from the level meter. 

But at the time of input the masking distance, if there is the true echo (the reflection 

echo from the powder surface or the liquid surface) between the level meter and the 

masking distance, even true echo is masked. 

For this reason, if inputting the masking distance, please set it with condition of no 

true echo (powder surface or liquid surface) between the level meter and the 

masking distance. 

! 
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『Time window adjustment』：The TW (Time window) is area where the reflected echo is determined. 

                                 When the reflected echo moves outside of the TW range because the                                

reflection strength of the reflected echo is momentarily too large, it might                          

take some time to determine the reflected echo. 

In this case, the “Time window adjustment” is used to manually move the 

TW area to the reflected echo. Default: 0.000m 

・Graph display 

『Trend curve』：Displays measured value trend curve when monitoring echo waveform (echo 

curve) is active. 

      The following items can be selected as the trend curve data to display. 

 ・Distance   → Distance from the level meter (m) 

 ・Level distance → Distance from 0% level (m) 

 ・Level percent → Measured level percent from 0% level (%) 

 ・Current value   →Output current value (mA) 

Default: Distance 

『Sensor Trend』：Displays measured level percent trend curve recorded at one minute intervals within 

the level meter. Default: No data 

・Self test 

Performs self test routine and if there are any fault detected then error code will be displayed. 

・Reset 

Returns the parameter value to the default setting or restarts a measurement. 

There are following two types of reset. 

"Measuring reset": restart measurement without affecting parameters. 

"Parameter reset": reset parameters to the default settings. 

 

Important："Parameter reset" 

*When parameter reset is executed, various set values return to the default value of the instrument. 

Therefore, when executing parameter reset, please record the setting value currently set before 

resetting. 

*Setting data that specifies the mask range and mask intensity will be reset, but please note that 

the setting made with the echo learning setting will not be cleared even if resetting is performed. 

 

 

・Current output Test 

   Simulate current output from the level meter. 

   The following outputs can be simulated. 

   ・Level percent ：-10% to +110% 

   ・Current ：3.55mA to 22.0mA 

 

  ・HART Communication setting 

It is an item of HART communication setting. The setting items are as follows.  

『Polling Address』  : Address setting of HART communication 

: Default value = 0 (Range: 0 to 63) 

For use in multi-drop, set to address 1 to 63 

For not use in multi-drop, set to address 0. 

『Preamble number』 : Preamble number setting 

: Default value = 5 (Range: 5 to 20) 

『Multi-drop mode』  : Multi-drop setting 

: Default value = Disable 

When setting value is enabled, the current output is fixed to 4 mA 

The multi-drop mode is set. 

『Dynamic variables (PV, SV, TV, QV)  』: Setting of dynamic variables 

: Default values 

: PV = Distance, SV = Level Distance, TV = Level%, QV = Unused  

Important: Normally the polling address is fixed to "0". 

If you do not use it with multidrop, you do not need to change it from the default value. 

If the number has been changed without any meaning, please return to the default value. 

! 

! 
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・Information 

This is item to confirms 『Sensor information』  and 『HART information』. 

『Sensor information』 is item to confirms ｢Manufacturer ｣ ,｢Device type｣ ,｢Serial number ｣ ,  

｢Firmware Version｣ and ｢Tag｣, etc. 

『HART Information』 is item to confirms ｢Software Version｣ and ｢Hardware revision｣, etc. 

 
・LCD display setting 

It is an item of status display and setting of LCD display unit 『GRAPHIC COM : GC』. 

Displays connection status, LCD type, LCD version information.  

The setting items are as follows. 

『LCD language』   : Display language setting of 『GRAPHIC COM : GC』  

: Default value = English 

: Setting contents: English / Japanese (Kana)  

『LCD indication value』 : Indication value setting of 『GRAPHIC COM : GC』  

: Default value = Distance 

: Setting content: Distance / Level distance / Level percent / Current value 

『LCD backlight』   : Backlight setting of 『GRAPHIC COM : GC』  

: Default value = Auto 

: Setting contents: Auto / ON / OFF 
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6. Operation of measurement waveform screen 
  The echo curves will be displayed by clicking on any of the navigation tree items except root view

｢MWLM-PR26 HART｣ and ｢Graph display｣ → ｢Sensor trend｣. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.12. Echo waveform details 

 

* If you are monitoring (recording), update of new recording will switch echo waveform to 

normal display, hence if a waveform is zoomed in, than zoomed presentation is quit and 

normal view is displayed. 

 

  ・Record, play, stop buttons 

 

 

                           Forward one recording 

                           Fast forward recording 

                           Replay recording 

                           Start recording 

                            Stop recording or stop replay 

                           Replay recording in reverse 

                           Fast rewind recording 

                           Rewind one recording 

 

By pressing the record button, you can check the waveform of the measurement state.  

The buttons other than the record and stop buttons will be active when monitoring stopped and  

when reading the previously stored echo trend curve.  

  

Measurement waveform 

Enlarged 

Print out (Document) 

Zoom out 

Zoom in 

Cursor used to show data points on the screen 

Echo Curve（EC） 

Echo Detection Curve（EDC） TimeWindow(TW）  

Horizontal axis: Distance from the level meter (m) 
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Last date displayed and No. of data 
Record, Play, Stop buttons 
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Right-click on the measurement waveform screen, the setting menu will be displayed. 

 

a．｢X –Y Axis settings｣：Change the axis range settings 

b．｢Curve select」 ：Selects curves to be presented 

c．｢Save｣ ：Saves the echo trend curves as a file 

d．｢Read｣ ：Recalls echo trend curves from file 

e．｢Option｣ ：Selects curve resolution and legend options 

f．｢Finish｣ ：Returns to the initial measurement graph 

 

Fig.13. Setting menu (context menu) 

 

 

a．｢X–Y axis settings｣ 

Right-click on the measurement waveform screen to display the setting menu. 

Click ｢X –Y Axis settings｣.  

｢X –Y Axis settings｣dialog will be displayed. 

The range of X axis and Y axis of measurement waveform screen can be set. 

 

 

 

  Enter appropriate values in each entry. 

  Click OK to accept entered values. 

  Click Cancel to exit dialog without changing values. 

  Click Default to set default values. 

Range of the X (measurement distance) and Y (reflection) axis 

are as following. 

         ・X axis ：0.000m to 71.000m 

     ・Y axis ：0 dB to 200 dB 

 

 

   Fig.14. X-Y axis settings dialog 

 

b．｢Curve select｣ 

Right-click on the measurement waveform screen to display the setting menu. 

Click ｢Curve select｣. 

｢Curve select｣ dialog will be displayed. 

The curve to display on the measurement waveform screen can be select. 

 

 

 

 

 ☑Curve types that checked in will be shown. 

  Click OK to accept selections. 

  

※The manual noise suppression curve (MNSC) will be 

presented only when service man logged in and has set the 

service parameter. 

 

   Fig.15. Curve select dialog 
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【Curve description】 

 EC・・・・ Echo curve 

This curve is curve that processed the raw curve and is always displayed.  

 EDC・・・ Echo detection curve 

This curve is threshold curve for detecting echo.  

This curve is curve obtained by superimposing ELC, MNSC, and NTC. 

(NTC : Noise threshold curve: threshold line for GND noise)  

EDC (NTC) of the curve after TW (Time window) has been raised by 10 dB as the 

default setting so as not to detect multipath waves. 

 ELC・・・・ Echo learning curve 

This curve is curve where the echo learning process was performed on the echo curve. 

This curve is automatically generated curve at the time of echo learning process 

execution. Echoes below ELC are masked. 

 MNSC・・・ Manual noise suppression curve 

This curve is a curve masked manually by parameters. 

Echoes below MNSC are masked. 

RC・・・・ Raw curve 

  This curve is raw reflection curve. 

This curve is curve before being processed into the echo curve. 

 

 

c. ｢Save｣ 

Right-click on the measurement waveform screen to display the setting menu. 

Click ｢Save｣. ｢Echo trend｣ and ｢Echo Image｣ save menu is displayed. 

 

 

 

 

 

 

 

 

Fig.16. Setting menu ,Save menu (context menu) 

 

There are two types of ｢Save｣, ｢Echo trend｣ store and ｢Echo images｣ store. 

・｢Echo trend｣  : Press the record button [ ● ] on the measurement waveform screen and save the 

recorded waveform until the stop button [ ■ ] is pressed on the PC. 

Current recorded series of echo curves will be saved as echo trend file (.etd). 

Click ｢Echo trend｣, Save echo trend dialog will be displayed, select save location, 

enter file name and click ｢Save｣. 

Default save location ＝ C:/Matsushima/MWLM-PR26 DTM V2.*.**/Echo trends/ 

・｢Echo Image｣ : Saves current active echo curve screen as a bitmap file (.bmp). 

Click ｢Echo image｣, Save echo image dialog will be displayed, enter file name  

and click ｢Save｣. 

Default save location ＝ C:/Matsushima/MWLM-PR26 DTM V2.*.**/Echo images 

 d．｢Read｣ 

Recalls echo curves from echo trend file saved previously. 

Right-click on the measurement waveform screen to display the setting menu. 

Click ｢Read｣. 

Open echo trend file dialog will be displayed. 

Select file you would like to recall and then click the Open button. 

You can display "echo trend" that was saved. 

 



- 19 - 

 

  e．｢Option｣ 

Right-click on the measurement waveform screen to display the setting menu. 

Click ｢Option｣. The option menu for normal rate and waveform name display is displayed. 

 

 

 

 

 

 

 

 

Fig.17. Setting menu , Option menu (context menu) 

 

There are two types of ｢Option｣, ｢Normal rate｣ and ｢Legend｣. 

｢Normal rate｣ : Selects high resolution or low resolution for echo curves. 

When clicked ｢Normal rate｣, a check mark (☑) is added to the left side of the character  

of ｢Normal rate｣. It means that a state with a check mark (☑) is set. 

By checking ｢Normal rate｣, the resolution of the curve rises and fine check can  

be done, but it takes time to update the waveform. 

(When check marking (☑) ｢Normal rate｣, the data size is twice as large as when  

no check marking ｢Normal rate｣.) 

 

｢Legend｣     : Activates or deactivates legend. 

When clicked ｢Legend｣, a check mark (☑) is added to the left side of the character  

of ｢Legend｣. It means that a state with a check mark (☑) is set. 

When the ｢Legend｣ is checked, legend will be displayed on the right of the echo curves 

as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

                Fig.18. Legend display  

 

 

  f．｢Finish｣ 

Click ｢Finish｣ to return to the initial measurement waveform screen.  

Right part of measured waveform without legend Right part of waveform with legend 

Legend 
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7. Adjustment of measurement parameter  

7-1. Application 

Set measurement unit, measuring object and level change rate. 

Click ｢User settings｣ → ｢Basic setting｣ → ｢Application｣. 

Navigation tree and application area are shown below in Fig.19. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.19. Application settings 

 

 

 

 

 

 

 

 

 

Fig.20. Application parameters 

 

1) Measurement unit 

Click on drop-down box and select measurement unit from either of【m】or【ft】. 

Changing this parameter will affect all other parameter values related to distance. 

Echo curves, measured value unit, measurement range span and echo learning distance will be  

changed. Please select the appropriate "measurement unit". 

2) Measuring object 

Click on drop-down box and select target measuring object from either of【Liquid】or【Solid】. 

For the case where a repose angle can be obtained on the object to be measured, please set to【Solid】. 

3) Level change rate 

Click on drop-down box and select level change speed from either of【Normal】or【Fast】. 

Set to【Normal】when the measuring object level change speed within the tank is slower than or equal  

to 1m / minute. Set to【Fast】when the speed is faster than 1m / minute. 

4) When three parameter settings are completed click the【Apply】button.  

By clicking apply button all DTM parameters will be transmitted to the level meter. 

 

 

 Apply  button    

Update parameter button. 

The values shown here are 

default values. 
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7-2. Measurement range span 

    Set measurement range and span. 

    Click『User settings』→『Basic Setting』→『Measurement range span』. 

Navigation tree view and application area are shown below in Fig.21. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig.21. Measurement range and span setting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.22. Measurement range and span parameters 

 

1) Full distance, Empty distance and their related percentage fields are shown in Fig.22. 

     (Refer to the outline drawing of the level meter for the 0m measurement setting) 

     Enter requested values in entry field. 

 

2) When parameter settings are completed click the【Accept】button. By clicking accept button all 

parameters will be transmitted to the level meter. 

 

   Important：After adjusting distance settings, you can enter percentage values as well. 

But you can not set empty percentage greater than the full percentage. 

Similarly you can not set full distance greater than empty distance. 

 

! 

Default values: 

Full: 0.000m - 100.0% 

Empty: 70.000m - 0.0% 

 Apply  button    

Update parameter button. 
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  7-3. Damping 

Sets amount of damping in number of seconds to respond fast step inputs. 

(Setting for the average measurement time) 

Click『User settings』→『Basic Setting』→『Damping』. 

Navigation tree view and application area are shown below in Fig.23. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.23. Damping setting 

 

 

 

 

 

 

Fig.24. Damping parameter 

 

1) Enter damping value in Time constant (T) field. 

 

2) When parameter setting is done click the【Apply】button. By clicking apply button all parameters will be 

transmitted to the level meter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Default value: 

0 second. 

 Apply  button    

Update parameter button. 
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7-4. Current output setting 

Select 0% - 100% current output selection and sets output current value during device failure. 

Alarm current is output, when measurement is not valid due to reflection echo loss or other failure. 

Click『User setting』→『Sensor adjustment』→『Current output setting』. 

Navigation tree and application area are shown below in Fig. 25. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.25. Current output setting 

 

 

 

 

 

 

 

 

 

 

 

Fig.26. Current output setting parameters 

 

1) Current output selection 

Click on drop-down box and select current output mode. 

  ・「4-20mA」 ：Settings for 4mA at a 0% measurement span and 20mA at 100%. 

  ・「20-4mA」 ：Settings for 20mA at a 0% measurement span and 4mA at 100%. 

2) Alarm current selection 

Click on drop-down box and select alarm output mode. 

・「Hold」 ：Remains at previous valid measured result. 

・「Max」 ：Output current is set to value selected in『Max. alarm current selection』.  

Selection range: 20mA / 20.5mA / 22mA 

  ・「Min」 ：Output current is set to value selected in 『Min. alarm current selection』. 

Selection range: 4mA / 3.8mA / <3.6mA 

・「Select value」：Output current is set to value entered in 『Selected alarm current value』. 

Input range: 3.550mA to 22.000mA 

3) When parameter setting is done click the【Apply】 button. By clicking apply button all parameters will 

be transmitted to the level meter. 

The values shown here are the 

default values. 

Current output selection: 

4-20mA / 20-4mA 

Alarm current selection: 

Hold / Max / Min / Select value 

 Apply  button    

Update parameter button. 
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7-5. Echo learning 

Echo learning is setting to mask interference reflections "false echo or noise echo" which is reflected 

from obstructions inside the tank such as beams and H steel, etc. within the radiation angle of the level 

meter. This masking of echo learning can prevent detection of interference reflections.  

About interference reflections 

Depending on the strength of false echoes, it can be suppressed by execute the echo learning function, 

but when the true echo can not be received or the reflection (dB) is extremely weak, it is necessary to 

change the installation position and suppress the interference reflections. 

Like this, if there are obstructions in the tank, please install the level meter to a place where the 

obstructions does not intrude within the radiation angle of the level meter beforehand. 

 

Important：Echo learning setting input the masking distance from the level meter. 

But at the time of input the masking distance, if there is the true echo (the reflection 

echo from the powder surface or the liquid surface) between the level meter and the 

masking distance, even true echo is masked. 

For this reason, if inputting the masking distance, please set it with condition of no 

true echo (powder surface or liquid surface) between the level meter and the 

masking distance. 

Click『User settings』→『Sensor Adjustment』→『Measurement adjustment』→『Echo learning』. 

Navigation tree and application area are shown below in Fig. 27. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

. 

 

 

 

 

Fig.27. Echo learning 

 

 

 

 

 

 

 

 

 

Fig.28. Echo learning execution 

Echo learning 

Execute button 

! 

There are no default values 

for echo learning distance. 
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1) Echo learning processing 

Click on drop-down box『Echo learning processing』and select requested function to execute. 

Following functions are available: 

・「Clear」 : Delete all echo learning data that has been executed. 

・「Update」   : Echo learning data that has already been executed will be deleted and updated 

with new echo learning distance. 

・「Addition」  : Addition of new learning data without deleting the echo learning data already 

entered. 

2) Echo learning distance 

Distance from level meter to execute echo learning. 

 

   Important：It is masked in the range of minus 1 m against the input distance. 

For example, in distance from the level meter, if the true echo from the object to be 

measured exists at 3 m and the interference reflection exists at 1.5 m,  

By inputting "3.000 m" and executing the echo learning processing, the interference 

reflection existing in 1.5 m can be masked. (The masked distance is 2 m.) 

The mask curve is the echo learning curve (ELC).  

If the manual noise suppression curve (MNSC) is no setting, the echo learning curve (ELC) 

become the echo detection curve (EDC) as it is. 

The echo detection curve (EDC) is generated about 7 dB above the echo curve (EC).  

Echo smaller than the echo detection curve (EDC) is masked. 

3) Click the Execute button below the『Echo learning distance』. 

The echo learning process is executed. 

Even if you click the Apply button in action area, echo learning processing will not be executed. 

Please be aware. 

 

 

 

 

 

 

 

 

 

 

Fig.29. Echo curves view before echo learning executed 

 

 

 

 

 

 

 

 

 

 

Fig.30. Echo curves view after the echo learning executed 

 

! 

The interference reflection echo   (Not masked) 

The interference reflection echo    (Masked) 

The true echo 

The true echo 
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7-6. Reset 

By executing reset you can return parameter values to default or re-start measurement without changing 

parameters. 

Click『User settings』→『Reset』. 

Navigation tree and application area are shown below in Fig. 31. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.31. Reset function details 

 

 

 

 

 

 

 

Fig.32. Reset execution 

 

1) Content of processing 

Click on 『Reset selection』and select requested type of reset. There are following two resets 

available. 

・「Measurement data reset」：Re-start measurement without changing parameters. 

・「Parameter reset」      ：Returns parameter values to the default setting. 

2) Click the Execute button. Reset is executed. 

Even if you click the Apply button in action area, Reset will not be executed. Please be aware. 

 

Important：Parameter reset 

*Parameter reset will return all parameters to the level meter default. Please take record of current 

values before executing the parameter reset. 

*The mask range and mask strength setting parameters adjusted by serviceman will be reset, but 

be aware that the echo learning settings (section 7-5) will not be reset. 

If you would like to reset the echo learning settings, select clear and execute echo learning as 

described in section 7-5. 

*When parameter reset is executed, the sensor trend is also reset. 

*Please be aware that resetting can not be performed while monitoring the measurement waveform 

screen 

Execute reset button 

! 
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7-7. Current output test 

Current output test is used to simulate current output from the level meter. 

This function is useful to output simulation current value, in order to check loop status with receive 

side. 

Click 『User setting』→『Current output test』. 

Navigation tree and application area are shown below in Fig. 33. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.33. Current output test 

 

 

 

 

 

 

 

 

 

 

Fig.34. Current output test execution 

 

1) Current output test value 

The following simulation methods are available as shown in Fig. 34. 

Click either of check box either of『Level percent』or『Current value』. 

・ Level percent 

Input simulation value in percentage. 

Level percent input range：-10.00% to 110.00% 

・ Current value 

Input simulation value directly in current. (Fig.34 shows current value mode selected.) 

Current value input range：3.550mA to 22.000mA 

2) Click the Output button to start simulation. 

When the simulation is active ｢Current output value｣ will be displayed in mA in the『Current output 

actual value』frame. 

3) Click the Stop button to exit simulation. 

When simulation stopped ｢Current output value｣ will display as 0.000mA. 

 

    Important： If you do not stop simulation as described above, simulation will continue 

and you can not observe measured values. 

! 
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7-8. Other settings 

    7-8-1. Sensor identification 

Set Tag, Descriptor, Message and Installation date of the level meter. 

Click『User settings』→『Sensor identification』. 

Application area is shown below in Fig.35. 

 

 

 

 

 

 

 

Fig.35. Sensor identification parameters 

 

Enter parameters in the appropriate entry field. 

Click the  Apply  button at the action area, to transmit parameters to the level meter.  

『Tag』：Default＝SENSOR 

Sets tag of the level meter. 

 Input: Up to 16 letters (Upper case alphanumeric characters only) 

『Descriptor』：Default＝PULSE-RADAR 

Set descriptor of the level meter. 

 Input: Up to 16 letters (Upper case alphanumeric characters only) 

『Message』：Default＝LEVEL METER 

Set message of the level meter. 

 Input: Up to 32 letters (Upper case alphanumeric characters only) 

『Date』：Default＝01/01/2018 

Set the installation date of the level meter. 

 

    7-8-2.Time window adjustment 

TW (Time Window) is area determined as the reflection echo. 

When the reflection intensity of the reflection echo temporarily changes greatly and the reflection 

echo moves outside the TW area, the TW may take time to judge the reflection echo. 

In such a case, the "Time window adjustment" is used to manually move the TW area to the 

reflection echo. 

Click『User setting』→『Sensor adjustment』→『Measurement adjustment』→ 

『Time window adjustment』and the following screen will be displayed. 

 

 

 

 

Fig.36. Time window adjustment execution 

 

Manual TW distance 

Enter the distance you would like to move the TW (distance from the level meter). 

After entering the value, click the Execute manual TW  button. 

The TW will be moved to the specified distance. 

Even if you click the Apply button in action area, the TW will not be moved. Please be aware. 

 

Important：If there is no the reflection echo at the distance that the TW moved then after a few 

seconds TW will return automatically to the actual reflection echo (true echo).  

But be careful that, if it is difficult for the level meter to determine the true echo or if there is no 

true echo (no echo) then the TW may not return to the original distance. 

Even if the reflection echo exists at the distance the TW moved, if the echo probability is lower 

than other reflected echoes then after a few seconds the TW will move to the reflection echo of 

the highest echo probability automatically. 

16 letters 

16 letters 

32 letters 

Date 

! 

Enter the distance to move 

Move TW button 
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7-8-3. Graph display 

     Display echo data table, trend curve and sensor trend. 

     a. Echo data table: 

The echo data table displays additional information of the detected echo which is larger than the 

EDC of the echo curve. Up to 128 echo data can be displayed. 

The echo data consistent with monitored or recalled echo curves. 

When clicking the [ ● ] button (recording button) on the measurement waveform screen, the echo 

data is updated according to the update of the echo curve. 

Click『User setting』→『Graph display』and the following table will be displayed below the echo 

curve. 

 

 

 

 

 

 

 

Fig.37. Echo data table 

 

b. Trend curve： 

The Trend curve represents the transition of trend data. 

The Trend data is a measurement value corresponding to 0 to 100% when monitoring the echo 

curve. The Trend data of measured value consistent with monitored or recalled echo curves. 

Click『User setting』→『Graph display』→『Trend curve』 and following screen will be 

displayed. 

 

 

 

 

 

 

 

 

 

 

Fig.38. Trend curve 

 

Right-click on the screen of the trend curve to display the trend curve setting menu. 

There are items of ｢X-Y axis settings｣ and ｢Curve select｣. 

 

 

 

 

 

｢X-Y axis settings｣ 

Click ｢X-Y axis settings｣ to display the settings dialog. 

Time is shown on the X axis. 

The ｢Full range｣ sets trend curve time range to full range of recording. 

If you are recalling saved data, it will display trend curve with full scale 

from start of recording to end of recording. 

The ｢User select｣ sets time range to entered value in minute unit. 

 The Distance is shown on the Y axis. 

 You can set the vertical axis range of the trend curve. 

 Click OK to apply entered values. 

 Click Cancel to exit dialog without changing values. 

 Click Default set to default values. 

Print out (graph image) 

Zoom out 

Zoom in 

Cursor used to highlight points on the graph 

Most left point is 

latest trend point 

time. 

Fig.40. X-Y axis settings dialog 

Fig.39. Trend curve setting menu (context menu) 
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｢Curve select｣ 

 Click ｢Curve select｣ to display the trend curve select dialog. 

 Select the trend curve to display. 

 

 ・Distance : Distance from the level meter (m) 

 ・Level distance : Distance from 0% level (m) 

 ・Level percent : Percent from 0% level 

 ・Current value : Current value displayed (mA) 

 Click OK to apply entered values. 

 Click Cancel to exit dialog without changing values. 

 

 

 

c. Sensor trend: 

As soon as power is supplied to the level meter, sensor trend stores measured level percentage values 

with 1 minute period in the memory of level meter. This sensor trend will be displayed on the sensor 

trend graph. 

Maximum 4096 data (about 2 days 20 hours 16 minutes) is recorded, and after that it is overwritten 

from old data. 

Click『User settings』→『Graph display』→『Sensor trend』, then following graph appear on the 

application area as shown below in Fig.42. 

 

 

  

 

 

 

 

 

 

 

 

 

 

Fig.42. Sensor trend graph 

 

 

 

※The graph above is the initial screen and no any data displayed yet. 

 

「Sensor data reset」 

Clicking the Sensor data reset button a confirmation dialog of "Do you want to clear the last record and 

strat a new record?". 

Clicking the Yes  button deletes all sensor trend data inside the level meter and start a new record. 

Once deleted sensor trend data can not be restored. 

 

 

 

 

 

 

 

Print out (document images) 

Zoom out 

Zoom in 

Cursor used to highlight data points on the graph 

The data within the level meter will be erased and new trend starts. 

Most left point is 

latest trend point 

time. 

information. 

 

Fig.41. Curve select dialog 

 

 

 

 



- 31 - 

 

Right click on the sensor trend screen. The sensor trend setting menu will be displayed.  

 

 

 

  

 

 

 

 

 

There are ｢Read from the sensor｣, ｢Read from the PC｣, ｢X-Y axis settings｣, ｢Save｣,  

｢CSV conversion｣ and ｢Finish｣ items in the sensor trend setting menu. 

Please click on necessary items and display and record. 

 

・「Read from the sensor」: Read sensor trend form the level meter. 

 

・「Read from the PC」：Read trend data from previously stored file in the PC. 

 

・「X-Y axis settings」：Sets range of the trend graph. 

 

 

 

 

 

 

 

 

 

 

 

 - X Axis (Time) 

Full range：Displays the full range of data from the beginning to the latest data stored in 

the level meter. 

User select：Displays data from the newest within the user set time range. 

- Y axis（Level percent） 

Set the vertical axis range for the trend curve. 

Range：-10.00％ to 110.00％ 

 

・「Save」 ：Saves current displayed trend graph to a file. 

(Enter a file name at the save screen to save.) 

 Save destination=C:/Matsushima/MWLM-PR26 DTM V2.*.**/Sensor trends 

 

・「CSV conversion」 ：Converts the saved trend data on the PC to CSV format and save to a file. 

 (Enter a file name at the save screen to save.) 

 Save destination=C:/Matsushima/MWLM-PR26 DTM V2.*.**/Sensor trends 

 

Important：Before opening CSV file in MS Excel, please open the CSV file once in 

text editor like Notepad and then do “Save” overwrite. 

There is possibility that multi-byte characters (like Japanese, Chinese or 

Korean etc.) appear not correctly. 

 

・「Finish」 ：Returns to the initial screen. 

 

! 

Fig.43. Sensor trend setting menu (context menu) 

 

 

 

 

Fig.44. Sensor trend X-Y axis settings 
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7-8-4. Self test 

Use self test to check for failure in the level meter or problem in the parameter set values. 

When you feel malfunction in the level meter, please execute self test. 

Click『User setting』→『Self test』and the following will appear on the application area. 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.45. Self test result (No failure) 

 

Click the  Execute sensor self test  button. 

When self test is active Device specific status field will be blank to indicate diagnostic process running. 

Once self test is completed result is displayed here upon. 

If there are no any malfunction detected then status will be OK. 

The status fields on the left side are related to the hardware of the main unit. 

The status fields on the right side are for the measurement and parameters. 

 

Important: If failure other than the lost echo detected, please contact your local 

Matsushima sales office. 

 

Even if you do not click the  Execute sensor self test  button, 

if there is any fault in the level meter, it will be displayed automatically.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.46 . Self test result (with failure) 

 

 

 

 

 

 

 

 

 

 

 

  

Execute sensor self test button 

! 
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7-8-5.HART communication setting 
 

Sets HART communication setting. 

Click『User settings』→『HART communication setting』and following screen will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.47. HART communication setting 

 

Position the cursor within each frame and click on it and enter the default value as a general 

rule. 

After input decision, please click the Apply button (parameter update button) on the lower right 

of the screen. Each setting is registered. 

 

『Polling Address』  : Address setting of HART communication 

: Default value = 0 (Range: 0 to 63) 

For use in multi-drop, set to address 1 to 63 

For not use in multi-drop, set to address 0. 

『Preamble number』 : Preamble number setting 

: Default value = 5 (Range: 5 to 20) 

『Multi-drop mode』 : Multi-drop setting 

: Default value = Disable 

When setting value is enabled, the current output is fixed to 4 mA 

The multi-drop mode is set. 

『Dynamic variables (PV, SV, TV, QV)  』: Setting of dynamic variables 

: Default values 

: PV = Distance, SV = Level Distance, TV = Level%, QV = Unused  

 

Important: Normally the polling address is fixed to "0". 

If you do not use it with multidrop, you do not need to change it from the default value. 

If the number has been changed without any meaning, please return to the default value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

! 
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7-8-6. Information 
 

This is item to confirms 『Sensor information』 and 『HART information』. 

『Sensor information』is item to confirms ｢Manufacturer｣,｢Device type｣,｢Serial number｣,｢Firmware 

Version｣ and ｢Tag｣, etc. 

『HART Information』is item to confirms ｢Software Version｣ and ｢Hardware revision｣, etc. 

 
a. Sensor information 

Click『User setting』→『Information』→『Sensor information』 then following sensor 

information will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.48. Sensor information 

 

 

 

b. HART information 

Click 『User setting』→『Information』→『HART information』 then following HART 

information will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.49. HART information 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



- 35 - 

 

7-8-7. LCD display setting  

It is an item of status display and setting of LCD display unit 『GRAPHIC COM : GC』. 

Click『User setting』→『Information』→『LCD display setting』 then following LCD display 

setting screen will be displayed. 

 

 

 

 

 

 

 

 

 

Fig.50. LCD display setting 

『LCD connection status』: Connection status display of『GRAPHIC COM : GC』  

: [ With connection ] : Connected state 

: [ No connection ]  : Not connected state 

: [ --- ]            : Level meter old version 

『LCD type』           : Type display of『GRAPHIC COM : GC』  

: [ Standard ] : Standard specification 

: [ CHN ]    : China specification 

: [ --- ]      : Level meter old version 

『LCD version』         : Software version display of『GRAPHIC COM : GC』  

: [ 2.** ]     : Software version 

: [ --- ]      : Level meter old version 

Important: About LCD connection status, LCD type, LCD version status display 

Updating of the status display is performed at the time of initial connection after starting 

this program and at parameter transfer. State of attachment / detachment of 『Graphic 

Com: GC』 and connection status display may be different. In this case, please click 

『Apply』 button (parameter update button) in the lower right of the screen. The status 

display is updated. 

『LCD language』   : Display language setting of 『GRAPHIC COM : GC』  

: When the LCD type is [ Standard ] , it becomes possible to set. 

: Default value = English : English : English notation 

: Japanese: Japanese kana notation 

『LCD indication value』 : Indication value setting of 『GRAPHIC COM : GC』  

: When the LCD type is other than [ --- ] , it becomes possible to set. 

: Default value = Distance  

: Distance : Distance indication from level meter. 

: Level distance : Distance indication from 0 percent level. 

: Level percent  : Percentage indication from 0 percent level. 

: Current value : Indication of output current value. 

『LCD backlight』   : Backlight setting of 『GRAPHIC COM : GC』  

: When the LCD type is other than [ --- ] , it becomes possible to set. 

: Default value = Auto  : Auto  : Backlight auto off 

: ON  : Backlight always lighting 

: OFF : Backlight always turns off 

Important: In case of LCD backlight [ Auto ] 

The back light turns on by the button operation of 『Graphic Com: GC』, and when there is 

no button operation for 30 seconds, the backlight turns off. 

Depending on the power supply voltage, the auto power save (APS) function is enabled. 

When APS is displayed in 『Graphic Com: GC』  

The backlight does not light up even if you operate the 『Graphic Com: GC』 button. 

  

! 

! 



- 36 - 

 

7-9. Termination of the program 
 

To exit the program, please select "Exit" in File on the PACTware toolbar and click on it.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Confirmation dialog of "Do you want to close the DTM?" may be displayed. 

Please click the [ Yes ] button. 

 
[ Matsushima DTM exit confirmation dialog ] 

 
 
 
 
 
 
 
 
 
 
 

Confirmation dialog of “You have changed PACTware data, Save changes?" 

may be displayed. Please click the [ No ] button. 

 
[Confirmation dialog of change data saving at the termination of the PACTware.]  

 
 
 
 
 
 
 
 

This concludes termination of the program. 

 
 
 
 

Fig.51. Termination of the program 
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8. Parameter list 

Sensor identification Liquid(Initial value) Solid(Initial value) Set value 

 Tag Tag SENSOR →  

 Descriptor  Tag information PULSE-RADAR →  

 Message Remarks LEVEL METER →  

 Date Date 01/01/2018 →  

Basic setting Liquid(Initial value) Solid(Initial value) Set value 

 

Application 

Measurement unit m →  

 Measuring object Liquid Solid  

 Level change rate Normal [<=1m/min] →  

 

Measurement 
range span 

Full set distance 0m →  

 Empty set distance 70m →  

 Full setting percent 100% →  

 Empty setting percent 0% →  

 Damping Time constant 0s →  

Sensor adjustment Liquid(Initial value) Solid(Initial value) Set value 

 

Current output 
setting 

Current output selection 4-20mA →  

 Alarm current selection Hold →  

 Max alarm current election 20mA →  

 Min alarm current selection 4mA →  

 Selected alarm current value 22mA →  

 
Measurement 
adjustment 

Echo 
learning 

Echo 
learning 
distance 

0m →  

HART communication setting Liquid(Initial value) Solid(Initial value) Set value 

 Polling address 0 →  

 Preamble number 5 →  

 Multi drop mode Disable →  

 Dynamic variable PV Distance →  

 Dynamic variable SV Level distance →  

 Dynamic variable TV Level percent →  

Information Liquid(Initial value) Solid(Initial value) Set value 

 

Sensor information 

Serial number 1 →  

 Firmware version 2.00 →  

 Order number ――― ―――  

 Factory adjustment date 01/01/2018 →  

LCD display setting Liquid(Initial value) Solid(Initial value) Set value 

 LCD connection status With connection →  

 LCD type Standard →  

 LCD version 2.00 →  

 LCD language English →  

 LCD indication value Distance →  

 LCD backlight Auto →  
Setting date:                

Operator   :                
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9. How to set when the password input screen is not displayed 

9-1. Auto start settings 

The auto start settings are settings to activate only Matsushima DTM using desktop icon. 

*Before making this setting, connect the HART modem (MHM-01 or MHM-02) to be used to the USB port of the 

PC. 

If it is not connected, since the COM port number is not displayed when setting the communication DTM, 

Be sure to connect. 

*Double-click the desktop icon (PACTware) without doing this setting 

Or when you start PACTware with "start"> "program"> "PACTware" 

If you start up in the initial screen or if you are using a third party DTM 

Other company's DTM may start up. 

In this setting, to distinguish it from other company's DTM, create icon of PACTware project file of  

Matsushima DTM, It is setting to activate Matsushima DTM by double clicking on that icon. 

Please make sure to set up the following 9-1-1 to 9-1-4. 

 

9-1-1. Starting the PACTware 

Double click on desktop icon (PACTware). 

The PACTware screen appears. 

 

 

 

 

 

 

Double click 

 

 

 

 

 

Click New in the toolbar "File". 

If another DTM is already running, a confirmation screen will be displayed. Click Yes. 

After that, please click No because the saving confirmation screen will be displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.52.PACTware main window 

Toolbar 

Expansion of toolbar 

Fig.53.File menu New 
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9-1-2. Confirmation of the device catalog  

Click "Device catalog F3" in the toolbar "View".The "Device catalog screen" is displayed. 

(* When "Device catalog screen" is already displayed, "Device catalog F3"Clicking it will disappear  

the "Device catalog screen".In that case, click "Device catalog F3" again on the toolbar "View" and 

Please display "Device catalog screen". ) 

"Generic HART DTM" "HART Communication" "MWLM / PR 26 / HART" in the table of Catalog 

Please confirm that 3 kinds of are displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Click the Update device catalog button under "Device catalog" Please update "Device catalog". 

The confirmation button will be displayed, please click the Yes button. Update "Device catalog". 

As a result of updating, please confirm that 3 kinds are displayed in the table of "catalog". 

After confirmation, please close the screen by clicking "x" in "Device catalog". 

(*If you do not close "Device catalog", (4) Save a project (see page 45) When saving the file,  

It will be saved with "Device catalog" displayed. When using a personal computer with a small screen Size, 

"Matsushima DTM" display area becomes narrow and it may be hard to see. ) 

 

*If "MWLM/PR26/HART" is not displayed even after update. 

There is a possibility that you have not done restarted the PC when there was an instruction to restart the PC at 

the time of installation, execute 9-1-4.Termination of the program and terminate PACTware and  

Please restart the PC. When reconfirming, please execute from 9-1-1.Starting PACTware. 

*If "MWLM/PR26/HART" is not displayed in the "catalog" table even if the PC is restarted, 

execute 9-1-4.Termination of the program and terminate PACTware. 

Please confirm that "MWLM - PR26 HART DTM V2. *. **" is installed in "Start"> "Windows system tool"> "control 

panel"> "program"> "program and function". 

If "MWLM-PR26 HART DTM V2. *. **" is not installed, please install "MWLM - PR26 HART DTM V2. *. **". 

If "MWLM - PR26 HART DTM V2. *. **" is installed, please install "Microsoft MSXML". 

When reconfirming, please execute from 9-1-1.Starting PACTware. 

*For installation of software, please refer to" 3-3. Installation of the Matsushima DTM "and " 4-2. 

Confirmation of the device catalog" and "(3) Installation of the Microsoft MSXML" in the separate sheet 

"Microwave level meter adjustment software DTM / PACTware Installation manual ". 

Fig.54. Confirmation of the device catalog 

Expansion of Catalog table 

“X”mark 

Update device catalog  

Expansion of Button 
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9-1-3. Create a project  

(1) Setting of the communication DTM 

Click "Project F2" in the toolbar "View".The Project screen is displayed on the left side of the screen. 

(* When "Project screen" is already displayed, "Project F2"Clicking it will disappear the "Project screen". In that 

case, click "Project F2" again on the toolbar "View" and Please display "Project screen". ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Move the cursor to "HOST PC" in the Project screen, right click and click the item "Add device". 

The Device for screen will be displayed. Please select "HART Communication" and click the OK button. 

"COM *" is displayed under "HOST PC" in the Project screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Right click 

Fig.55. View menu Project 

Fig.56. Communication DTM setting 
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Move the cursor to "COM *" displayed in the Project screen, right click and select "Parameter" and click. 

COM Parameter will be displayed on the right side of the screen. 

The COM Parameter is displayed on the right side of the screen. Select COM listed under Serial Interface 

(¥Device¥VCP0) (for MHM-01) or (¥Device¥USBSER000) (for MHM-02) and click OK button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

  

*Select the COM number listed in 

(¥Device¥VCP0) or (¥Device¥USBSER000). 

 

*If the other set values are not the values as 

shown in this picture, please set the 

numerical value as shown in this picture. 

Right click 

Fig.57. Communication DTM COM port setting 
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(2) Setting of the device DTM 

"COM *" displayed in the Project screen has been changed to "COM" with a different number. 

Move the cursor to the changed "COM", right click, and click on the item of Add device. 

The Device for screen will be displayed, please select "MWLM / PR 26 / HART" and click the OK button. 

"MWLM/PR26/HART" is displayed in the Project screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Right click 

Fig.58. Device DTM setting 



- 43 - 

 

Move the cursor to "MWLM/PR26/HART" displayed in the Project screen, right click Click on the item of Parameter. 

As the password screen (Login screen) is displayed, please do not enter anything in the password, and click the 

OK button. 

"Matsushima DTM" in English is displayed, please click the × button to delete the Project screen. 

(*If you do not close "the Project screen", (4) Save a project (see page 45) When saving the file,  

It will be saved with "the Project screen" displayed. When using a personal computer with a small screen Size, 

"Matsushima DTM" display area becomes narrow and it may be hard to see. ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Right click 

Click the X button 

Clear Project screen 

Fig.59. Matsushima DTM display and the project screen erase 
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(3) Setting of the options 
 
Click "Options" in the toolbar "Extras". 

The "Options" screen will be displayed, so please confirm that it is the setting as shown in the "Options" screen 

below. 

If it is not the setting as shown on the "Option" screen below, please set it according to the picture and click the 

OK button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

  

*Please set follow the settings on the screen. 

Fig.60. Options setting 
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(4) Save a project 

Save the auto start setting with a name. 

Please click "Save as .." in the File of the tool bar. 

After clicking, please save the save destination as "desktop", save file name as "MatsushimaDTM", click the save 

button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The icon "MatsushimaDTM" shown below appears on the desktop. 

 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

Input "MatsushimaDTM"  

Fig.61. Save a project 
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9-1-4. Termination of the program   

In order to validate the saved setting value, it is necessary to terminate the program once. 

Please select "Exit" in File in the tool bar and click. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The confirmation dialog of "Do you want to close the DTM?" may be displayed. 

Please click the “Yes” button. 

 
 
 
 
 
 
 
 
 
 
 
 
 

The confirmation dialog of "You have changed PACTware data, Save changes?" may be displayed. 

Please click the “No” button. 

 
 
 
 
 
 
 
 
 

This concludes termination of the program. 
 
 
 
 
 
 
 

 

 

  

Fig.62. Termination of the program 
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9-2. Language setting  

Start Matsushima DTM. 

Double click on the desktop icon (MatsushimaDTM.PW5). 

The password input screen is displayed, please do not input anything and click "OK" button. 

Matsushima DTM will be displayed automatically. 

Move the cursor to "Language" on the DTM screen and click and select the desired language. 

The confirmation item will be displayed, please click the OK button. 

 (For Windows 11, only English setting is available.) 

Please select "Save" in File in the toolbar and click. 

After clicking, in order to validate the saved setting value, it is necessary to terminate the program once. 

The way to terminate the program is the same as 9-1-4. Termination of the program.  

Please terminate the program and complete the language setting. 

 

The figure shows an example set to Japanese. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Please do termination of the program. (Refer to 9-1-4.) 

 

 Fig.63. Language setting  
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When using Japanese, Korean, Chinese, garbled characters may occur. 

Please make the following settings to display characters correctly. 

 

Select Start> Windows System Tools> Control Panel> Clock, Language, and Region> Region. 

The region setting screen is displayed. 

Click on the "Administrative" tab in the region setting screen and select the corresponding language in "Language 

for non-Unicode programs". 

 

The figure shows an example set to Japanese. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 

 
 
 

 

 

 

 

 

 

Please select the corresponding 

language. 

Click the Change system locale button. 

Please click OK button. 

The PC restart confirmation screen is 

displayed. 

 

Click the Restart Now button. 

The PC will restart. 

Fig.64. Setting of language for non-Unicode programs  
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9-3. Change of the startup file name (MatsushimaDTM.PW5) 

 

It is a setting method when changing the startup file name (desktop icon display). 

It is used when you make a mistake startup file name or want to change the startup file name. 

Start Matsushima DTM. 

Double click on the desktop icon (MatsushimaDTM.PW5). 

The password input screen is displayed, please do not input anything and click "OK" button. 

Matsushima DTM will be displayed automatically. 

Please select "Save as..." in File in the toolbar of PACTware and click. 

Please set the save destination to "desktop and input the desired file name in the save file name and click the 

save button. 

In order to activate the setting, it is necessary to terminate the program once. 

The way to terminate the program is the same as 9-1-4. Termination of the program. 

Please terminate the program and complete change of the startup file name. 

After changing the startup file name, the icon of the file name changed to the desktop is displayed. 

There are existing icons on the desktop, but there is no problem in terms of adjustment. 

To delete an unnecessary icon, move the cursor to the icon, 

Since there is a "Delete" item when right clicking, please click "Delete". 

Unnecessary icons are deleted. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Input the desired file name 

Please do termination of the program. (Refer to 9-1-4.) 

Fig.65. Change of the startup file name  
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10. Multi-drop settings 

 

Important: Multi-drop settings  

Up to 63 units can be connected with the HART specification (when polling addresses 1 to 

63, 0 not used), but the number of units to be connected depends on the power supply 

capacity. In addition, it takes time to acquire measurement data. 

When 63 units are connected by one second communication per one unit, 

It takes at least 63 seconds to update the data. 

If there is an interrupt at the maintenance PC, it will be delayed further. 

Please do not use for a system with fast level change. 

 

 
10-1. Connection configuration 

 

Below is a simple connection example of the device configuration.  

 
 

Example) When three units are connected 

 
 
 
 
 
 
 
 

 
     4mA      4mA  
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

Power 

supply 

DC24V 

 

＋ 

- 

＋ 

＋ ＋ 

- - - 

4mA × 3=12mA 

4mA 

Power supply capacity 

24 V × 12 mA = 0.288 VA  

or more 

HART 

modem 
HART 

modem 

Load resistance 

250 Ω 

250Ω 

Host PC 

Primary master 

 

Maintenance PC 

Secondary master 

 

Level meter × 3 

 

Matsushima DTM 

Level meter maintenance 

HART Universal commands 

Acquisition of measurement data 

Dynamic variables (PV, SV, TV) 

Address =1 

 

 

Address =2 

 

 

Address =3 

 

 

! 

Fig.66. Multi-drop connection example 
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10-2. PC settings 

Important: PC settings  

HART communication is a slow communication with a baud rate of 1200 baud.  

(Bit rate is 1200 bps.)  

(The amount of communication data per second is about 109 bytes / second at 11 bits / byte.) 

Normally, the serial communication setting of the PC has become fast communication 

setting with bit rate of 9600 bps (872 bytes / second) to 38400 bps (3490 by / second).  

Communication in multi-drop is performed frequently . 

When the serial communication setting of the PC is fast communication setting, 

"Communication error" occurs on the communication DTM . 

Therefore, it is necessary to set the serial communication setting of the PC  

for HART communication. 

 
The setting method differs depending on HART modem. Please set according to steps 10 -2-1. for 

MHM-01 and 10-2-2. for MHM-02. 

10-2-1. In case of MHM-01 
Please connect HART modem to the PC. 

(If you do not connect the HART modem to the PC, the "USB Serial Port (COM *)" of the HART modem 

will not be displayed in "Ports (COM & LPT)" of "Device Manager"). 

<For Windows 8, 10, 11> 

Please select "USB Serial Port (COM *)" of HART modem with "Start"> “Right click”> “Device manager”>  

"Ports (COM & LPT)" and click. The property screen of "USB Serial Port (COM *)" will be displayed. 

<For Windows Vista, 7> 

Please select "USB Serial Port (COM *)" of the HART modem with "Start"> "Control Panel"> "System and 

Security"> "System"> "Device Manager"> "Ports (COM & LPT)" and click. 

The property screen of "USB Serial Port (COM *)" will be displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

! 

Fig.67. Device Manager > Ports (COM&LPT)  

Fig.68. USB Serial Port (COM*) Properties > Port Settings  
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In the "USB Serial Port (COM *) Properties" click the "Port settings" tab and click "Advanced". 

The “Advanced Settings for COM*" screen will be displayed. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please set as shown in Figure 70 and click “OK”. 

(USB Transfer Sizes: Receive= Transmit = 256 bytes, BM Options: Latency time = 1 msec, 

Miscellaneous Options: Serial Enumerator = Unchecked, Disable Modem Ctrl At Startup = Checked ) 

It returns to the "USB Serial Port (COM *) Properties". 

Fig.69. Advanced Settings for COM*  (Default value) 

Fig.70. Advanced Settings for COM*  (Setting value) 
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Click "OK" in the "USB Serial Port (COM *) Properties". 

It returns to the "Device Manager". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please click "×" in the device manager and exit the device manager. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Fig.71. USB Serial Port (COM*) Properties > Port Settings  

Fig.72. Device Manager > Ports (COM&LPT)  
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10-2-2. In case of MHM-02 
There is no need to change settings. If you changed settings to values other than default values, 

please follow steps below to return them to the default values.  

Please connect HART modem ”MHM-02” to the PC. 
(If you do not connect the HART modem ”MHM-02”to the PC, the "M-system COP-HU USB modem (COM 
*)" of the HART modem will not be displayed in "Ports (COM & LPT)" of "Device Manager"). 
<For Windows 8, 10, 11> 
Please select " M-system COP-HU USB modem (COM *)" of HART modem with "Start"> “Right click”> 
“Device manager”>  
"Ports (COM & LPT)" and click. The property screen of "USB Serial Port (COM *)" will be displayed. 
<For Windows Vista, 7> 
Please select " M-system COP-HU USB modem (COM *)" of the HART modem with "Start"> "Control 
Panel"> "System and Security"> "System"> "Device Manager"> "Ports (COM & LPT)" and click. 
The property screen of " M-system COP-HU USB modem (COM *)" will be displayed. 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

Fig.73. Device Manager > Ports (COM&LPT) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.74. M-system COP-HU USB modem (COM*) Properties > Port Settings 
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In the " M-System COP-HU USB modem (COM *) Properties" click the "Port settings" tab and click 

"Advanced". 

The “Advanced Settings for COM*" screen will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.75. Advanced Settings for COM*  (Default value) 

 
If the settings differ from Figure 118, click "Defaults" and then click "OK". 

It returns to the " M-System COP-HU USB modem (COM *) Properties". 

 
Click "OK" in the " M-System COP-HU USB modem (COM *) Properties". 

It returns to the "Device Manager". 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.76. M-system COP-HU USB modem (COM*) Properties > Port Settings 
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Please click "×" in the device manager and exit the device manager. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.77. Device Manager > Ports (COM&LPT) 
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10-3. Setting of the communication DTM and the Target address setting screen  

 

10-3-1. Setting of the communication DTM 

 

Important: Setting of the Communication DTM   

It is necessary to set the host PC as "Primary master" and the maintenance PC as 

"Secondary master". 

For the host PC, please set as "Primary Master" according to your HART communication 

device and Software of the host PC. 

 

Configure the maintenance PC. 

Please connect your HART modem to the PC(the maintenance PC). 

(If you do not connect HART modem to the PC, COM port number will not be displayed at the 

communication DTM setting.) 

Double click "Matsushima DTM" icon created with 9-1.Auto start settings on the desktop and start 

"Matsushima DTM". 

Double click to display the password input (Login) screen. 

If you do not enter the password and click the "OK" button, the initial screen will be displayed. 

 

 

 

 

 

 

 
 

 

 

 

 

Fig.78. Procedure of starting the Matsushima DTM  

 

 

Click "Project F2" in the toolbar "View".The Project screen is displayed on the left side of the screen. 

(* When "Project screen" is already displayed, "Project F2"Clicking it will disappear the "Project screen". In that 

case, click "Project F2" again on the toolbar "View" and Please display "Project screen". ) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

  

! 

Do not enter any [Password] 

click「OK」. 

Double-click on the 

desktop icon 

 

Initial screen 

Fig.79. View menu Project 
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Move the cursor to "COM *" displayed in the Project screen, right click and select "Parameter" and click. 

The COM parameter setting screen will be displayed on the right side of the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

Right click 

Fig.80. Communication DTM (COM parameter setting) 



- 59 - 

 

Adjust the item of Serial Interface to COM of HART modem to use. 

Set the item of Master to "Secondary Master", the item of Communication timeout to "3" seconds and  

click the "OK" button at the lower right of the screen. 

The setting value becomes valid, the COM parameter setting screen disappears and  

"Project screen" and "Matsushima_DTM" are displayed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.81. Communication DTM ( COM parameter setting (enlarged) ) 

Fig.82. COM parameter setting > Setting button (enlarged)  

Fig.83. Project screen and Matsushima DTM screen 

Project screen 

Matsushima DTM screen 
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10-3-2. Setting of the Target address setting screen  

 

Move the cursor to "MWLM PR26 HART" displayed in the Project screen, right click 

Select "Additional functions" and click "Target address". 

The target address setting screen is displayed on the right of the screen. 

This screen is for setting the target address when connecting to the level meter with the maintenance PC. 

Target address setting is not done here. However, if the target address is not "0", set it to "0". 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Right click 

Fig.84. Target address setting screen 
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Please click "MWLM PR26 HART DTM V2. * Parameterization" tab and display "Matsushima DTM". 

 

 

 

 

 

 

 

 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Please click "×" on "Project screen". 

"Project screen" disappears and "Matsushima_DTM screen" and "Target address tab" are displayed. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig.85. Target address setting screen (enlarged) 

Fig.86. Project screen and Matsushima DTM screen and Target address setting tab  

Project screen 

Matsushima DTM screen 

Target address setting tab 

Matsushima DTM screen 

Target address setting tab 

Fig.87. Clear Project screen  
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Save the setting value. 

If you want to overwrite "Matsushima DTM.PW5". 

Click "Toolbar"> "File"> "Save". 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

If you want to change the name and save,  

Click "Toolbar"> "File"> "Save as". 

Enter the change file name and click "Save". 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter the change file name 

Fig.88. Save Project 
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In order to validate the saved setting value, it is necessary to terminate the program once. 

Please select "Exit" in File in the tool bar and click. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The confirmation dialog of "Do you want to close the DTM?" may be displayed. 

Please click the “Yes” button. 

 
 
 
 
 
 
 
 
 
 
 
 
 

The confirmation dialog of "You have changed PACTware data, Save changes?" may be displayed. 

Please click the “No” button. 

 
 
 
 
 
 
 
 
 

This concludes termination of the program. 
 
 
 
 
 
 
 
 

 

 
 
 
 

Fig.89. Termination of the program 
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10-4. HART communication setting (Multi-drop setting of the level meter) 
 

 

Important: HART communication setting (Multi-drop setting of the level meter) 

This setting is to connect the PC to the level meter not set to multi-drop setting and to set 

the level meter to multi-drop setting. 

Before wiring the level meter to the multi-drop, wire the level meter separately as shown in 

Fig.1. (See Fig.1, Example connection between the level meter and the computer). 

Please connect the PC to the level meter and set the level meter to multi-drop setting one 

by one. 

This setting can also be set in the LCD display unit "Graphic Com: GC". 

 

10-4-1. Starting the program 

 

Double click "Matsushima DTM" icon on the desktop and start "Matsushima DTM". 

Double click to display the password input (Login) screen. 

If you do not enter the password and click the "OK" button, the initial screen will be displayed. 

 

 

 

 

 

 

 
 

 

 

 

 

Fig.90. Procedure of starting the Matsushima DTM  

 

 

10-4-2. Confirmation of the target address 

 

Please click the tab of "MWLM PR 26 HART DTM V2.* Target address" on the initial screen after starting 

"Matsushima DTM" and display "Target address setting screen". 

Please confirm that the target address of "Target address setting screen" is "0". 

If the level meter is not set to multi-drop setting, the target address is "0". 

When the target address is other than "0", please set the target address to "0" because it can not 

communicate with the level meter that is not set to multi-drop setting. 

After confirming "target address", please click the tab of "MWLM PR26 HART DTM V2.* Parameterization"  

and display "Matsushima DTM screen". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

! 

Do not enter any [Password] 

click「OK」. 

Double-click on the 

desktop icon 

 

Initial screen 

Fig.91. Target address setting screen  
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10-4-3. Connection of the communication 

 

Click "Toolbar"> "Device"> "Connect" to connect the PC to the level meter. 

Upload confirmation dialog will be displayed, please click "OK".    

Communication between the PC and the level meter starts. "Matsushima DTM" will be "online" after 

communication is over. 

 
 
 
 
 

 

 

 

 

 

 

10-4-4. HART communication setting (Multi-drop setting) 

 

Click "User setting"> "HART communication setting". 

"HART communication setting screen" is displayed. 

Set the items of polling address sequentially from 1 up to the number of connected devices. 

Set the item of multi-drop mode to "Enable". 

Set PV, SV, TV, for the item of dynamic variable. 

Please click the "Apply" button at the bottom right of the screen after setting. 

The set value is transferred to the level meter. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Fig.92. Device communication connection and upload confirmation dialog 

Fig.93. HART communication setting screen (Multi-drop setting) 
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After the transfer of the HART communication setting value, the target address becomes the setting 

address. 

Example) If you set to "1" the polling address, the target address is "1". 

 

 

 

 

 

 

 

 

10-4-5. Disconnection of the communication 

Click "Toolbar"> "Device"> "Disconnect" to disconnect communication. 

 

 

 

 

 

 

 

 

<When setting multiple level meters> 

In the order of the following items,please set the level meter to multi-drop setting one by one.  

10-4-2. Confirmation of the target address 

10-4-3. Connection of the communication 

10-4-4. HART communication setting (multi-drop setting) 

10-4-5. Disconnection of the communication 

In the item of "10-4-2. Confirmation of the target address", please set the target address to "0" and connect 

with a level meter that is not set to multi-drop setting. 

 

10-4-6. Termination of the program 

After setting, exit the program with "Toolbar"> "File"> "Exit". 

 
 
 
 
 
 
 
 
 
 

The confirmation dialog of "Do you want to close the DTM?" may be displayed. 

Please click the “Yes” button. 

 
 
 
  
 
 
 

The confirmation dialog of "You have changed PACTware data, Save changes?" may be displayed. 

Please click the “No” button. 

 
 
 
 
 
 
 
 
 
 

Fig.94. Target address setting screen (after setting) 

Fig.95. Device communication disconnection  

Fig.96. Termination of the program 
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10-5. Multi-drop use notes 
 

10-5-1. About multi-drop wiring 

When wiring the level meter to the multi-drop, please wire the level meter that is set to multi-drop setting. 

If the level meter is not set to multidrop setting, set the level meter to multidrop setting by doing the following 

settings. 

10-2. PC settings 

10-3. Setting of the communication DTM and setting of the Target address setting screen 

10-4. HART communication setting (multi-drop setting of level meter) 

 

10-5-2. About the host PC 

Please follow the host PC software you use. 

Please set the HART master setting of the host PC to "Primary Master". 

 

10-5-3. About the maintenance PC 

Be sure to do the following settings. 

10-2. PC settings 

10-3. Setting of the communication DTM and setting of the Target address setting screen 

 

(1). Connection of the communication of the level meter ("Device"> "Connect") 

Please connect the communication of the level meter after set the address of the level meter that you 

want to connect on the target address setting screen at the offline state that is disconnected the 

communication of the level meter. ("Device"> "Connect")  

When level meter adjustment completed, Please disconnect the communication of the level meter and 

do it the offline state. ("Device"> "Disconnect") 

 

<Target address setting> 

Click the tab of "MWLM PR26 HART DTM V2. * Target address" to display the "Target address 

setting screen" and set the target address to the address of the level meter to be connected. 

After setting the "Target address", please click the tab of "MWLM PR26 HART DTM V2. * 

Parameterization" to display "Matsushima DTM screen". 

 

Example) When you want to connect to the level meter of polling address "1" 

Please set the target address to "1". 

 

 

 

 

 

 

 

 

 

 

 

 

Important: Connection of the communication of the level meter  

The level meter and the maintenance PC are 1: 1 communication. 

You can not access other level meters when online. 

In order to access other level meter, disconnect the communication of the level meter and 

do offline, connect the communication of the level meter after setting the target address. 

 

(2). Adjustment of the level meter 

Adjust the level meter with "7. Adjustment of measurement parameter". 

 

Important: In case of multi-drop setting 

"7-4. Current output setting" and "7-7. Current output test" can not be set because the 

fixed current 4 mA output. 

 

Fig.97. Setting of Target address  

Set the address of the level meter to be connected. 

! 

! 


